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 ����	# �� �)�� Software �'�  Hardware 
���	%� %&�
 �*���	�����	�+�
����
 IntellCAD �� &
%������� 

• Microsoft Windows 98SE , MSWindows NT 4.0-	�� MS Windows XP 
• -��)!�	��)'.'	/�� Intel Pentium -	���	0)�)�� 
• -��)!�)���+��!��
 ���!  64 MB  -	������)�� 
• *������)��

�1�	2  ���2 �!��
���!  60 MB �+�-	&���	%� %&�
����%0� 	)��&�
�3'2%&)�!��
 �'� �����	

�+�-	&���)!�-'�� 
• � 	34 CD-ROM �+�-	&���	%� %&�
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 ��	��	�������	����+� ����!)�&���	�+�-� ���%��
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�	�-)��
��	%� %&�
 CAD�� � !
���	%�%%&�
  
��	��	����+���	%� %&�
�3'2%��
( �'��	��
 Folder �����0�
� 1�	2  ���2 �'��	��
���� Start 
� Windows 98 
,Windows NT 4.0 -	�� WindowsXP � !�&%���&%� 
 	�-)��
��	%� %&�
 ������	#��#$
��	�'���	� &���	
��
������	�!�)�� Experience level �*�����5�����	���%��
�
��	%� %&�
��	
��
����
��	��	� � !��
-��'���
���� Beginner 6$�
����5���	
��
����	���
���
��&��*���7�� �%�#��
%��
��	
��
�	� &�����	�!�)�� Advanced �0����	#�����
���+��&�
%��
( � �����)�� 300 �+��&�
6$�
.��
�� ����	#��
��'��!���'
	� &� Experience level ���� � 8�!-'&
%� %&�
��	��	���	0��'�)�0� � 
 ��	%� %&�
������	����&%���&%�-'&
������
���.�� CD-ROM ��
 CAD�� ��� �%�#���������	�	�����	%� %&�
 .��
��
��
�0����	#�+��9��&%�� �%���&��%�� &
%��������0� � 
  

1. 
���.�� CD %� %&�
��
 CAD�� ����� CD-ROM drive 
2. 	���	�	����+�
�� -	�����'�����
 Start>Run 
3. 
����
��
 Open *��*2 d:\setup � ! d -��!#$
 ����%+��-��
��� CD-ROM drive 
4. �'�� OK �'��+�%���&��%��%��
( ��
-�����%���� 
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 .��
������	#�	���%��
�� CAD��  �)!��	�'��� Start > Programs > CAD�� > CAD�� 
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 ������+���	�	�!� CAD�� �'�) %&)��	��	����+�
��� !��: )��� )�2
-�� �����5��*�!
%&) Drawing ��'��( � ! 
���
���
��
���%&)������ Template �������)�� Icad.dwg  

• .��
��
������	#�+�-� -��)! Units ��
��	)&  �'���	%&�
 Grid �'� �)����
%&�)�&�;	 �'���	�+�-� 
���
%��
( � ����� �&� Drawing ����+�'&
���	��

-�� 

• .��
��
������	#�+�-� %&) Layers *��<;%��
( � ����� 
• .��
��
������	#�+�-� 	)�%&) Title block �'�Border ������ �)!� ����������&� 
�/��	&�
�������	�	���%�� Start ���� CAD�� �������
-�$�
����	��9 �&����� Tip of the Day �����!�������

)�"���	
��
�� �'�����	#�	�!� �� �%'� �)'�  �)!��	�'���������� Help > Tip of the Day �%�-�� ���%��
��	���� 
 
Tip of the Day ����0�*�!
�%��' �#������%&) Check box �����
��
������ Show Tips On StartUP � ��&��� 
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������	#�+�
��
�-���%��
��
 CAD�� �'���)�%��
( � � ���� ��	�� 
 �'��+�-� '+� &���
 

Toolbars �'���	�� 
�	���=���+��&�
 (Command bar) �'���	�� 
�#��������'��� Status bar ������'��
��

-���%��
-'&���
 CAD��  

 

 
 
A ����	#�	&���'��!� Menu bar ���)�
 ����� 
B ����	#�	&���'��!���	
��
�� �'���	�� 
 �'���	�& �	�!
��
��	���
��� �'���	�*����+��&�
 Commands �'�
Macros 
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C ����	#*��*2�+��&�

� Command bar �'��	&�%+��-��
)�
��-����� 
D ��� Drawing ����� 

�-���%��
 Window 
E %&)�� 
*��& ��
.��
��
�� User Coordinate System �+�-	&���	-�/���� Drawing 
�
�������%� 
F ��	�� 
�#��������'��
 Status bar ���� ������	���
���, %+��-��
*��& �@��/�&�, ���� Layer �'��#������ Settings 
G ����	#'�� �'�)�
�#���	���
��� Toolbars ��-����� 
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	������ Shortcut 
 

���� Shortcut ���)��*���
-.��
�� ����	#
���+��&�
 � ��!��
�� )�	) �	0)  ���� Shortcut ���� 
�$�������������	
� �/A��)���
����2 (Right-Click) ���)&%#/ -	�� Toolbar � !��� ��
���� Shortcut ���$���!���&�)���'���� ��'��	2 
-	�����)&%#/ 

���������	� �/A��)���
����2 (Right-Click)  ��� Toolbar %&)-�$�
 -	����� Status bar ��	��	��0���� 
%&) 
���� Shortcut �$�����*���
-�����	#����� ��:  -	���:  Toolbar � � �%�#����5�'&�;B���	�'���)&%#/ Entity �������)��
-�$�
%&)�$���� �'�� �/A��)���
����2 (Right-Click)  ����� �!)�&� ��	��	��0���� 
%&) ���� Shortcut �$�����*���
��	����� Modify �&�)&%#/ ����'����&���   

��)���	�� 
 ���� Shortcut �*�����	%&�
��� Snap ���)&%#/�&�� ����	#�+�� �� ! %��
� �/A� Shift ���
�)� �'�)�$
 
� �/A��)���
����2 (Right-Click)  ���
 �0� ���*��������
 Drawing 

 
������	 ���������� Toolbars 
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���	���%�� 
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�� CAD�� �	&�
�	� ������	�� 
 Toolbar �$��� !��%��!���'�) � !����'��	2 

Standard �'� Draw 2D �'� Modify 6$�
.��
��
������	#������+���	 �:  -	�� ��:  �*����%��
-������&��8�)���	
��

��� � �'�.��
��
��!&
����	#������	��
 ��'��	2 
-��� � ���!�� � !
� ���� Shortcut .��
��
������	#�������:  -	��6���
� �%'� �)'� 

.��
��
��!&
����	#������+�
-� ��'��	2 ����� 
�!���&�� �� 
��� �/A�
-C� -	�� �/A��'0�� � 	)�#$
 ��	�� 
��5��/A�
�������  � !��	�	�!��+��&�
������� View > Toolbars ���������!&
����	# �+�-�
-� �� 
 -	��6��� ToolTip 6$�
��5�%&)
�!�!�)����
��	���
�������� 
 ������+� Cursor ��)�
���/A�%��
 ( �� ��'��	2  

��'��	2 ����	#�� 
.'��� Docked (%� �&����)��� )�2-	����'��	2����) -	����� Floating ('�!���	� 
.��
������	#'�� !��!%+��-��
� �) 6$�

���� Floating ����5� Toolbar ����� Title bar �'��: � � �'�����	#�����
�+���)�
� ��/������*�������+�
�� �'��0����	#!�� �!�!� � �)! ��)���� Docked ��5� Toolbar ����������	�� 
-&)��� 
Title bar -	���: � � �'��0!&
�������	#!��-�!�! �%��&����-�����&���	�����%����)�����
-���%��
 Drawing 
�����&�� 

• Toolbar ��� Docked ����	#'���&���)�
�� Drawing � � �)!��	��	�'�������������	�� 
Toolbar 
�'&�;B����%��
��	�' �����	
��
����������5� Undocked 

• ��	�+�
-�%+��-��

�*������'&�;B� Toolbar ������
'&�;B�� �� � !� �/A� Ctrl �B����'���&� 
• ��	��'����!��! Toolbar ����	#'���&���
�%+��-��

-��� ��&��� 
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• ��	!��-�!�! Toolbar ���$���!���&���	��� Cursor �������� Toolbar �'�!��-�!�! %��-&)'��<	 
�'�'����'��!���� � ��&��� 

 
��	�'��� Toolbar ���%��
��	�� 
 
1. � �/A��)���
����2 (Right-Click)  ���
 �0� ��� Toolbar �����5���� Docked -	�����%+��-��
Status 

bar �+�-	&���	�� 
 Toolbar ��
 ���� Shortcut  
2. �'��� Toolbar %��
��	�� 
 (����	���
-��!#�� ���-���) 
3. #�� Toolbar �&������� 

� ���� Shortcut �0
-��'��� Toolbars 
4. ��	�'��� Toolbars 
� Dialog box ����� 
�!�� �'�� �/A� OK 

 
 
���� �������
	������� �������
	(Command bar) 
 

�	���=���+��&�
(Command bar) �����	
���)������	#��
 Toolbar 
�'&�;B���� Dockable 
-���%��
 Window ������)��+�-	&���	*��*2�+��&�
 �'� ��#��� �'���	
��
����
��	��	������5�����)�� ��)���	�� 
 
�	���=���+��&�
(Command bar) ����	#�'���� �������� View > Command Bar -	����	� �/A� F3 ����� �	��
�=���+��&�
(Command bar) �	��9	�-)��
 Toolbar �'� Drawing 6$�
�����		�& ��	�+�
��� �#$
����		�&  
������.��
��
��!&
����	#'�� �	���=���+��&�
(Command bar) ��������)�

�%+��-��
����( � ��� )� 

�����
 ��� �	���=���+��&�
(Command bar) ��5���� Floating ��� ����	#'�� �	���=���+��&�

(Command bar) ���)��-��� -	�� 
%� ���
�� 
8�* drawing � � � !������ � %+��-��
����-�����  �	���=���+��&�

(Command bar) ���	&�
-������ *� � � !�&%���&%� 6$�
��5���� docked 

 
�"����	�"���( Status bar) 

 
��5��#� ���'��
 
� )��� )�2��
 CAD�� ����� 
�����'�������!)���
�&���	
��
��  &
���(�	�!
���6��!���)�) 

�#�����	
���+��&�
-	����	*	���	&��+��&�
, %+��-��
*��& ��
 Cursor B. �@��/�&�, ������
 Layer ����+�
���!��
��@��/�&� 
��, 	���������, ��+�-�&�����, �#��� snap, �#��� grid,�#��� ORTHO, Entity snap, Model space, Tablet 
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������ Prompt box 
 

Prompt box  ���)��� )�2�'0�������� 
�$�����������	
�� �+��&�
%��
(
� CAD�� 6$�
���� 
%&)�'��� %��
( ��

�+��&�
�&��( (�'��!�&� Context menu 
� AutoCAD)      .��
��
������	#�����'�� Prompt box �����)�

�
%+��-��

 �0� � -��%��
��	�: �0
-��'������/A� x �/��� ����)� 

.��
������	#�:  ��:  Prompt boxes � �� !�'������� Tool > Options �'��'����� Tab ��
 Display �'� 
���  Display Prompt Boxes  
 

 
 

 
  

 
 
�����#�������
	  
  


� CAD�� ��)�"��'���
���+��&�

����%��
( � ���� 
• ��	�'����+��&�
������� 
• ��	�'���'����/A��� Toolbar 
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• ��	*��*2�+��&�

� �	���=���+��&�
(Command bar) 
��
�+��&�
 ��5��+��&�
����+�
�� �'�)!&
�
�� 
%&)�'��� �*���
-�.��
���=�����%&)�'��� �*����+��+��&�
%���� � !�����

�+��&�
   -��.��
��%��
��	���+��&�
����	#�+�� �� !��	�'�� Done 
�Prompt box -	����	� �/A� ESC  
  
.��
��
������	#
���+��&�
���� 
��B��+�'&
�+�
��
��+��&�
-'&��!���0� � %&)�!��
���� �B�������!�����%	
 Line �!��

�&�� .��
��
�������
���+��&�
��	�'����8�*��
�+��&�
 Pan ��'��!�%+��-��
��	 � Drawing ��-����� �*�����������!��������
�'�!������� ���-�$�
��
����%	
 -	������'��!���	%&�
�����
 Snap -	�� Grid � ��&��� 

 
 �����������
	��	���� 

��	
���+��&�
��
�����&�� ����	#�'������	�!��	��
�������
-�
��
�� 
��	
��
��	�!��	��
�������
-�
��
�� ���$���!���&���	�+�-� 	� &� Experience level �&����
)���+�-� ��5�

���	 � !����	�������5�	� &� Experience level �!���'�) �'�#���&
��% �
-� ��'�)
�	� &� Experience level ����%&) 
Toolbar 
-��'����������/  �+�-	&���	��'��!�	� &���	
��
���@��/�&� Experience level ����	#�'������ Tools > 
Options �'��'����� Tab ��
 General 

  
 

 �����������
	$�� Toolbars 
��	�'������/A�%��
 (  �� ��'��	2 ����5���	�=���+��&�
�����
-�$�
 
 
 Note: ���������	�� Toolbar ��
������������������������ Experience level ��������������������

���� ��� ����!�"����������� Experience level ����#$�� #$�%��&����'������(#$��������� Experience level ��"('�� 
Toolbar ����$)��"��	(�&*� &�����������$(������������������+��*��� Experience level &�"��%�$)����� Tools > 
Options #$� $!�	(� Tab 
�� General 

 

� ��'��	2 �������
����	�!�)�� Flyout 6$�
 Flyout ����5�������� �%�!��!�������� �/A��&�� � !�/A��&������

����-'��!��'0�( ��� ���'��
�)���
�/A�  �����.��
��� ����/A� ���
�)� Flyout �0���	��9�/A��+��&�
�*����%�� -���'����/A�
  �/A�
�&�����'�!��5��/A�-'&� ��
 fly-out �&��� 
 
�����������
	��	 ����� �������
	(Command bar) 
 

��	
��
���*�!
���*��*2�+��&�
 �'��  Enter �	B���� �	���=���+��&�
(Command bar) �� 
�!���'�) � !�+��&�

���.��
��
��*��*2���	��9������ �%�#�� �	���=���+��&�
(Command bar) ���� ��� 
�!�� �����*��*2�+��&�
�&������	��9��� 
Status bar ��� 

 
������	�������
	�����%� 
 

.��
������	#�����
��
���+��&�
� ��6�+�� � � !���%��
�'�����������-����
��	&�
�'�) �*�!
.��
��
���  ��=� 
Spacebar -	�� Enter -	����	�  Mouse �/A��)���� �0����	#�	�!��+��&�
����-�����
��� ��&��� 
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���&��'�����: %��,������������� ��&����������-!"-.	(� �����/�� ��&���(Command bar) �1 ���$)���������	�����#��
�$�� ���� multiple ����	(�����!�"��� ��&���������� ���������  ��&��� Circle Arc #$�Rectangle 
�� ��&�������2 �")��
,��������	������&�1� �1�-(��# ����*3" ESC �1&�"��%&!��&*� ��&������ 

 
������	������������
	���� 
 

#��.��
��
���+�'&
�+�
��
� �	���=���+��&�
(Command bar) .��
��
������	#�	�!�
��
���+��&�
����6����+��&�

� ��� � � !���	�!�)�� Nesting �0�����	�+��&�
-�$�
8�!
�
%���	�+�
����
�+��&�
����+�'&
�	��+��!��  �)!��	*��*2��	���
-��! 
Apostrophe (‘) -����+��&�
���.��
��
��*��*2 ���� ‘cirlce �'� ’line -	��’pyramid ��5�%�� 8�!
%���	�+�
��6���
�+��&�
� ��
� CAD�� � !
����� �'� Toolbar %��
( ����+�
��
�'&�;B�����������5�#���+�-� ��5�����	�����	
��
��
�&�
-�  !�%&)!��
���� ��	�'����� ��	���
��
 Grid ��	��
8�* Zoom �'�Snap  &
�&�� �����.��
��
������	�+�
��
�
'&�;B�6����+��&�
� ���'�) �&��0���'&��������	
���+��&�
����/ �	���%�����
���!������	&�
 

 
����� �����������
	 �%
(����� 
 

CAD�� ��-���%��
 �����0� �	�)&%���	
���+��&�
 � !����	#�� 
� � �)!��	� �/A� F2  6$�
-���%��
�������0�
�	�)&%� �+��)� 256 �		�&  � !��5������%� -��.��
��%��
��	��'��!���'
�0����	#�+�� �� !  

1. ����	#�'����+�� �
�-�$�

�)�"� &
�'��)��� 
• �'��� Tools > Options > Display 
• *��*2�+��&�
 Options �'��  Enter �'��'���'������ Tab ��
 Display   

2. 
����
 Command Lines To Track 
-�*��*2�+��)��		�& �+��&�
���%��
��	�� 
 �'��'�� OK 
 
��	0 �)��	��: ��	�� 
-���%��
 �*���!��� ���	�+�
���&�� %��
�  F2 �*�����:  �'��  F2 ����	&�
�*����:  

  
������	�� Scripts 
 

CAD�� ����	#�&��$��&��%����	
���+��&�
 �/��&��%��� � �)! Script Recorder 6$�
���& �&��%��%��
 ( ���
.��
�� � ��+��)� �'�����	#������	�!���
��
��� � -'&
��������0��&��$� Script Recorder �'�) 
��/��+��&�
 �'�Option 
%��
( ���.��
��
��*��*2��
 �	���=���+��&�
(Command bar) ��#���&��$����	��&�
.��
��
�����&�

-�-!/ ��	�&��$� �'�
�����'�
�+� Script ������+�
������	&�
 �0��� �.''&*"2%�� script �&�� (  
    
������
))��(��*���(Correcting mistakes) 
  
 -��.��
�� 	���$�)�� 
���+��&�
.� *'�  -	���+�� !���%&�

� .��
�� ����	#!�����	�+�
��(Undo) -	��-)��'&���	
�+�
�� ���	���! ( ��#$
�&��%�����%��
��	   -��!��������� ����	# �+���	� ��-����'&���� �� !
���+��&�
 Redo  
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����������	 CAD
�  
 
 .��
��
������	#�+���	�	&��%�
 CAD�� 
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